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1. Introduction 
 

1.1. About Terabee 
 
The smallest and lightest addition to the TeraRanger Evo sensor family provides versatile                         
performance and value for money! Optimized for indoor distance sensing, Evo Mini offers                         
ranging capabilities from just 3 cm up to 3.3 m using a 27 degree Field of View. Easily                                   
switch from single-pixel to multi-pixel modes, as well as close-range and long-range modes,                         
to adapt to your sensing needs.  
 

 
Figure 1. TeraRanger Evo Mini sensors, top view 

 
Evo Mini has zero open electronics and provides an ABS protected enclosure, resulting into                           
a dust-proof and robust operation. Benefit from Arduino & Raspberry Pi sample codes and                           
free ROS packages to get your projects up and running in no time!  

 

1.2. Symbols explanation 
 
The following symbols are used within the document: 
 

 
This symbol indicates specific recommendations in order to run the sensor in the                         
intended way. 
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1.3. Technical Specifications 
 

Table 1 - Technical specifications of TeraRanger Evo Mini 
Product codes  TR-EVO-MINI-USB / TR-EVO-MINI-I2C 

Performance   

Detection Principle   Infrared Time-of-Flight 

Light Source Wavelength  940 nm 

Use Environment  Indoors 

Repeatability  < 5 mm 

Output Distance Resolution  1 mm 

Field of View  27° 

Projected Reception Area  48 cm x 48 cm @ 1 m 

Operation  Pixel (px) modes: 1px, 2px, 4px (2x2) 
Ranging modes: short-range, long-range 

Range   
 
Please see “Performance Matrix” table for more details Accuracy 

Update Rate 

Electronics        

Supply Voltage VDC   5V DC  +/-5% 

Current Consumption (average)  50mA 

Initialization Time  < 1 s 

Communication       

Serial Interfaces  USB 2.0 Micro-B 
UART, +3.3V level, 115200,8,1, None 
 I2C, +3.3V level, 400 kHz 

Visual Notification  2 x LEDs (built-in backboard) 

Mechanical data       

Dimensions  42 x 30 x 13 mm  (incl. backboard) 

Weight  9 g (incl. backboard) 

Operating Temperature  -20°C to 75°C 

Housing Material   ABS 
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Mounting Style  2 holes for M2 screws 

Type of Connection   USB Backboard: USB 2.0 Micro-B 
I2C/UART Backboard: DF13-7p connector 
Hub Evo Backboard for use with TeraRanger Hub Evo 

Conformity       

  CE, RoHS 

 
 

1.3.1. Performance Matrix 

Table 2 - Performance matrix for the  different range and pixel modes 

Range mode    Short-Range mode    Long-Range mode 

Pixel mode    1px mode  2px mode  4px mode    1px mode  2px mode  4px mode 

Range    0.03m to 
1.35m 

0.03m to 
1.35m 

0.03m up to 
1.35m 

  0.03m to 3.3m  0.03m to 2.3m  0.03m up to 
1.65m 

Accuracy    Up to 
+/-1.5cm 

Up to +/-1.5cm  Up to +/- 2cm    Up to +/- 2cm  Up to +/-1.5cm  Up to +/- 3cm 

Update Rate    Fixed 40Hz  Fixed 13Hz  Fixed 6Hz    Fixed 20Hz  Fixed 8Hz  Fixed 4Hz 

 
Specifications are derived from tests in controlled conditions (target with 80% diffuse reflectivity, indoor fluorescent lighting, 
ambient temperature around 25°C). Note that bright sunlight, target surface reflectivity and other variables can affect sensor 
performance 
 
 

1.3.2 Communication interfaces 

Table 3 - Communication interfaces for the  different range and pixel modes 

Interfac
e 

  Short-Range mode    Long-Range mode 

    1px mode  2px mode  4px mode    1px mode  2px mode  4px mode 

USB    Yes  Yes  Yes    Yes  Yes  Yes 

UART*    Yes  Yes  Yes    Yes  Yes  Yes 

I2C*    Yes        Yes     

Hub Evo            Yes     

 
*Please note that UART and I2C data communication is supported by the same interface backboard 
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1.4. Pixel modes introduction 
The TeraRanger Evo provides 6 operating modes: 3 pixel modes and 2 range modes. For                             
more details on how to switch between the operating modes, please refer to section 5.  
 
Benefit from 3 distinct pixel modes with 1 pixel resolution, 2 pixel resolution and 4 pixels                               
(2x2) resolution. Please see table 4 for a visual example for each pixel mode.  
 

Table 4 - TeraRanger Evo Mini operating modes introduction 

1px mode  2px mode  4px mode (2x2) 

 
Sensor outputs 1 distance. 

 
 
 

 
Sensor outputs 2 distances. 

 
 
 

 
Sensor outputs 4 distances on 

a matrix of 2x2. 
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2. Mechanical integration 
 
2.1. Modular design (clip-on, clip-off) 

 
The mechanical design of the main sensor module (black) allows easy assembly to its                           
backboard (yellow) using a simple ‘clip-on’ technique. When clipping the two together,                       
please ensure there is no visible gap between the black and yellow parts.  
 

   

Figure 2 - modular design of the TeraRanger Evo Mini sensor  
 

2.2. Mechanical design and mounting 
 
TeraRanger Evo Mini distance sensor offers an ABS housing (both: sensor and backboard)                         
with an option to mount the sensor using 2 holes compatible with M2 screws. Figure 3                               
illustrates external dimensions of TeraRanger Evo Mini sensor. 
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Figure 3 - TeraRanger Evo Mini external dimensions, USB backboard 

 
Please note that the overall sensor dimensions remain unchanged when using the                       
I2C/UART backboard. The only affected dimension is the opening of the connector. 
 
Both USB and I2C/UART Backboards include two slots for mounting the sensor using                         
standard M2 screws. The following methods can be used to mount the TeraRanger Evo                           
Mini sensor:  
 

1. Front-panel mount using the M2 screws 
2. Back-panel mount using the 2mm ledge on the front side of the sensor 

 
Figure 4 illustrates the two different mount methods. The prior solution allows for easy                           
surface attachment and rapid evaluation of the sensor. The latter provides a more discreet                           
installation and supports design-in projects by installing the sensor behind a surface (e.g                         
panel), ideally with 2mm thickness.  
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  Figure 4. Front-panel mounting (left image); back-panel mounting (right images) 
 

2.3. Mounting solutions 
   
When choosing a place for mounting the TeraRanger Evo Mini, please consider the                         
following recommendations: 
 

● Mounting close to sources of heat or strong electromagnetic fields can decrease the                         
sensing performance 

● Do not mount anything directly in front of the sensor or in a cone of approximately                               
+/-35° around the central optical axis of the sensor 

● Within the first meter from the sensor, avoid objects with high surface reflectivity in                           
a cone of approximately +/-45° around the central optical axis of the sensor 

● It is better to avoid having other sources of Continuous Wave or modulated IR light                             
close to the sensor 

● Please consider that dust, dirt and condensation can affect the sensor performance 
● It is not advised to add an additional cover in front of the sensor 

 

 

During assembly and integration, please observe all common ESD precautions. All                     
optical surfaces (sensor front) should be kept clean and free from contact with                         
chemicals. 
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3. USB backboard use 

3.1. LED Indication 

3.1.1. Normal operation 

 
Three LED indicators are present on the USB backboard, and are visible through the back                             
side of the yellow plastic case. 
 

Table 5 - LED indicators of the USB backboard 

LED designator  Description 

PWR (ORANGE)  The Power LED is ON whenever the sensor is powered  

RED  Flashes briefly on startup to indicate proper initialization;  
then switches off 

GREEN  Blinks 8 times at power up.  
GREEN LED blinks every 5 seconds when the sensor is streaming                     
distance data 

 

 
Please note that the number of LEDs and their signalization logic differs between                         
USB backboard and I2C/UART backboard  

 

3.1.2. Error messages and troubleshooting 

 
Table 6 - USB backboard LEDs troubleshooting 

LED 
designator 

Sequence  Signification  Corrective actions 

RED  Continuous 
blinking 

Sensor has detected a fault         
and has stopped functioning 

Check that the sensor is         
properly connected to the       
backboard, then restart the       
sensor 

RED / 
GREEN  

Both LEDs 
blinking 
continuously  

Sensor has detected a fault         
in the sensor initialisation       
process 

Check USB output for details 
of Error 
 
Verify that the sensor is 
properly connected and 
re-power the unit 
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RED / 
GREEN 

Alternate 
blinking (red / 
green / red / 
green / etc) 
with 1 s 
intervals 

Sensor is not initialized       
because previous firmware     
upgrade was interrupted  
 
Sensor can not be operated  

Force a Device Firmware  
 
Upgrade by connecting the       
sensor to the Graphical User         
Interface and, without     
pressing Connect, hold “Shift”       
on your keyboard and click on           
File > Upgrade Firmware. The         
GUI will enter Upgrade Mode.         
For more details please refer         
to Section 3.2.3. 
 

 
 

 
Please note that the number of LEDs and their signalization logic differs between                         
USB backboard and I2C/UART backboard 

 

3.2. Graphical User Interface (version 1.0.31) 
A free Graphical User Interface (GUI) is available online, providing an easy way to visualize                             
distance data on your Windows OS. This is useful for demonstration, testing purposes and                           
checking some of the basic parameters of the sensor. It also provides a way to easily                               
upgrade the firmware running on the device.  
 
Please ensure you are using GUI version 1.0.3 or later (the current version only supports                             
sensor’s 1px mode) The TeraRanger Evo Mini GUI is available for download under the                           
“Downloads” section of the Evo Mini product page, or by following the link below:  
 
https://www.terabee.com/wp-content/uploads/2019/04/TeraRangerEvoInstaller_v1_0_3.exe 
 

 

If the TeraRanger Evo Mini is used in 2px mode, 4px mode or in Text print out                                 
mode with the GUI, it will not stream any distance. Please refer to Section 5 for                               
more information about the pixel and print out modes. 
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3.2.1. Prerequisites 

 
For usage on Windows 7 and Windows 8, please download the Virtual COM Port driver                             
from http://www.st.com/en/development-tools/stsw-stm32102.html and follow the         
”ReadMe file” instructions given by the installer. After successful installation, unplug the                       
interface for a few seconds, and plug it back in. The virtual COM port should now be                                 
available on your PC. 
 

 
Users of Windows 10 do not need to download this driver as the built-in Windows                             
driver is recommended. 

 

3.2.2. Basic Operation with the GUI, supporting 1px mode 

 
Make sure your TeraRanger Evo Mini is connected to a USB port on your computer. In the                                 
GUI select File > Connect. You should immediately see a distance reading in millimetres                           
and the status change to ‘Connected’. 
 

 
Figure 5 - TeraRanger Evo Mini GUI for 1px mode 
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Each time the TeraRanger Evo Mini is connected to the GUI (powered), the sensor uses its                               
default configuration parameters (1px mode, binary print out mode). To switch between                       
other configuration modes please consult section 5 for more details.  
 

 

In cases when the GUI is not streaming distance data, after successful physical                         
connection to a personal computer, please reconnect the sensor to the computer                       
by disconnecting and connecting the sensor. Should the issue persist, please                     
contact Terabee team at support@terabee.com for further guidance.  

 

3.2.3. Firmware Upgrade 

The following section summarizes steps to upgrade the firmware running on your sensor.                         
This can be helpful upon a new product firmware release (informed by Terabee) or should                             
there be a necessity to re-flash your existing device firmware.  
 

 
The current firmware version on your TeraRanger Evo Mini can be found by                         
selecting Help > About in the graphical user interface 

 
Please note that the Upgrade Firmware feature is only supported on Windows 7, 8 and 10                               
OS. Please carefully follow the steps outlined below to enable firmware upgrade and avoid                           
permanently disabling your device. 
 

 
Please be advised that wrongful execution of the upgrade functions can result into                         
permanent sensor firmware deletion 

 
Table 7 - Firmware upgrade instructions 

Step  Action  Description 

1  Download GUI  Download the latest version of the TeraRanger Evo GUI 
on your computer. The GUI is available from TeraRanger 
Evo Mini product page. Please refer to section 3.2 for 
more details 

2  Install GUI  Install the downloaded version of the TeraRanger Evo 
GUI on your computer. Please refer to section 3.2 for 
more details 

3  Download FW  Download the latest Evo Mini firmware file from the 
TeraRanger Evo Mini product page, or provided by the 
Terabee technical support team 

4  Initiate 
upgrade FW 
procedure 

In the GUI, select File > Connect and then File > 
Upgrade Firmware.  
Click ‘Yes’ in the dialog window to confirm the firmware 
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upgrade procedure 

5  Upgrade FW  A new dialog window will present instructions on               
selecting the firmware file and launching the upgrade               
process. Read the instructions carefully before           
continuing.  
Press ‘Select File’ and select the new firmware file with                   
Windows File Explorer 
Press ‘Upgrade’ and wait until the operation finishes 

6  Close upgrade 
FW procedure 

Once the upgrade is over, the dialog box shows                 
“Firmware upgraded” in the bottom left corner. Close the                 
dialog. The sensor is ready to stream with the latest                   
firmware. 
Note that the dialog box will automatically close after 5                   
seconds 

 
 

 

Once initiated, the upgrade firmware procedure must follow all the steps. If the                         
procedure exists before finishing, the sensor will switch to error mode. Please refer                         
to section 3.1.2 for more details 

 

3.3. Connecting the TeraRanger Evo to a Host Computer 

3.3.1 Windows OS 

In Windows it is also possible to use any terminal emulation software for data display.                             
Terabee often works with and suggests using HTerm software. Please follow the provided                         
link to download the software file (http://www.der-hammer.info/terminal/), and select the                   
version 0.8.2 of the software. 

Next, extract the downloaded zip file to the selected folder, open it and double click on the                                 
“HTerm.exe” document. Connect the TeraRanger Evo Mini to a computer and select the                         
corresponding USB port (click “R” button to refresh the port list). Please configure the                           
software with the following parameters:  

Baud rate : 115200 bit/s 
Data bits : 8 
Parity bit : None 
Stop bit  : 1 
 
For easier data reading, select the “LF” option from the “Newline at” drop-down field. See                             
Figure 6 below for visual instructions. 
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Figure 6 - HTerm parameters for TeraRanger Evo Mini 

Once the USB port is selected and the parameters correctly set, click on the “Connect”                             
button. The distance data will now appear in the “Received data” box (see Figure 7). Please                               
note that the HTerm emulation software support data stream in all pixel modes, including                           
1px mode, 2px mode and 4px mode.  
 

 

Figure 7 - Data stream on HTerm software: 
 1px mode (left); 4px mode (right) 

To communicate with the terminal emulation software, a command in hexadecimal needs                       
to be sent using the “Type” field. Make sure the “Hex” checkbox is selected (checked) and                               
the “Type” field has “HEX” as an option selected. Figure 7 shows an example of the                               
command which allows data to be shown in TEXT mode in 4px mode. 

3.3.2 Mac Os 

When using a Mac OS it is also possible to use any terminal emulation software for data                                 
display. Terabee often works with and suggests using the Coolterm software. Please follow                         
the provided link to download the software file (https://freeware.the-meiers.org/).  

Next, double click on the “CoolTermMac.dmg” file and then on the Coolterm icon. Connect                           
the TeraRanger Evo Mini to a computer and click the “Options” button. Select the                           
corresponding USB port (click “Re-Scan Serial Ports” button to refresh the port list). Please                           
configure the software with the following parameters:  

Baud rate : 115200 bit/s 
Data bits : 8 
Parity bit : None 
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Stop bit  : 1 
 

 

Figure 8 - Coolterm parameters for TeraRanger Evo Mini 

Once the USB port is selected and the parameters correctly set, click on the “Connect”                             
button. The distance data will now appear (see Figure 9). Please note that the Coolterm                             
emulation software supports data stream for all pixel modes, including 1px mode, 2px                         
mode and m4px mode.  

 

Figure 9 - Data stream on Coolterm software: 
 1px mode (left); 2px mode (right) 

To communicate with the terminal emulation software, click Connection > Send String. A 
new window opens, allowing to send command to the Evo Mini. Make sure the “Hex” 
checkbox is selected (checked) as the command needs to be sent in hexadecimal, and then 
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click the “Send” button. Figure 9 also shows an example of the command which allows data 
to be shown in 1px mode or in 2px mode. 
 

4. I2C/UART backboard use 
The TeraRanger Evo Mini sensor can be controlled through a UART interface using an 
I2C/UART backboard. 

 

Figure 10 - I2C/UART backboard front view 

4.1. I2C/UART pinout 
The I2C/UART backboard uses a single 9 pin Hirose DF13 connector for interfacing to the                             
host system. The mating connector is a Hirose DF13-9S-1.25C with crimping contacts                       
DF13-2630SCF (tin) or DF13-2630SCFA (gold). Please consider the mechanical stability of                     
the mated connectors and avoid any kind of excess force on the connector (during                           
installation and once integrated) and follow the recommendations in the Hirose DF13                       
series datasheet (available here: https://www.hirose.com/product/en/products/DF13) to           
ensure a reliable connection. 

 
Table 8 - Pinout and description (According to DF13 datasheet) 

Pin  Designator  Description 

1  Tx  UART transmit output. 3.3V logic 

2  Rx  UART receive input. 3.3V logic 

3  GND  Power supply and interface ground 

4 SDA I2C serial data line. 3.3V logic 

5 SCL I2C serial clock line. 3.3V logic 

6  rfu  RESERVED FOR FUTURE USE 

7  5V  +5V supply input 

8  GND  Power supply and interface ground 

9  rfu  RESERVED FOR FUTURE USE 
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4.2. LED Indicators 

4.2.1. Normal operation 

The I2C/UART Backboard has three built-in LEDs behind the yellow case to visualise                         
feedback of the sensor status. Table 9 lists the functionality of each LED of the I2C/UART                               
backboard.  
 

Table 9 - LED indicators of the I2C/UART backboard 

LED  Description 

PWR (orange)  Power indicator, constantly ON when 5V is supplied 

Rx (red)  
Tx (green) 

I2C/UART receive and transmit indicators.  
Single blink for each data received or sent 

 

4.2.2. Troubleshooting 

 
Table 10 - I2C/UART backboard LEDs troubleshooting 

LED 
designator 

Sequence  Signification  Corrective actions 

RED  Continuous 
blinking 

Sensor has detected a fault         
and has stopped functioning 

Check that the sensor is         
properly connected to the       
backboard,  
then restart the sensor 

RED / 
GREEN  

Both LEDs 
blinking 
continuously  

Sensor has detected a fault         
in the sensor initialisation       
process 

Check I2C/UART output for 
details of Error 
 
Verify that the sensor is 
properly connected and 
restart 

RED / 
GREEN 

Alternate 
blinking (red / 
green / red / 
green / etc) 
with 1 s 
intervals 

Sensor is not initialized       
because previous firmware     
upgrade was interrupted.     
Sensor can not be operated. 

Run the Firmware upgrade.       
Please refer to Section 3.2.3         
for more details 
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4.3. Electrical characteristics 
Table 11 - TeraRanger Evo Mini power consumption 

Parameter  Minimum  Maximum  Average 

Power supply 
Voltage input (V) 

Current consumption (mA) 

 
4.5V 

25mA 

 
5.5V 

75mA 

 
5V 

50mA 

Interface logic levels 
(referenced to +3V3)  

LOW 
HIGH 

 
 
- 

2.3 

 
 

1 
- 

 
 
- 
- 

 
 

5. USB/UART Normal operation 

5.1. USB/UART list of commands  
 

Table 12 - List of commands for TeraRanger Evo Mini 

Command (HEX)    Command description 

00 11 01 45  PRINT OUT MODE             TEXT 

00 11 02 4C  PRINT OUT MODE             BINARY 

00 21 01 BC PIXEL MODE                      1PX MODE 

00 21 03 B2 PIXEL MODE                      2PX MODE 

00 21 02 B5 PIXEL MODE                      4PX MODE 

00 61 01 E7 RANGE MODE                   SHORT RANGE MODE 

00 61 03 E9 RANGE MODE                   LONG RANGE MODE 

 
Please refer to Section 3.3 for instructions on how to send commands to the TeraRanger                             
Evo Mini sensor using a host computer and the HTerm emulation software. 
 

 
Each command message frame must be transmitted in a continuous stream, ie. 
not byte by byte 
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It is advised to maintain a time interval of a few microseconds between two 
messages for proper command registration 

 

5.2. Printout modes: text and binary 

5.2.1. TEXT mode 

This mode provides users with data transmission readable to a human eye. When                         
streaming data using the HTerm software in single-pixel mode, the measured distances are                         
displayed in millimeters under the form of a 3 to 5 bytes message: xxxx\n (the number of                                 
bytes is dependant on the number of digits in the distance reading) 
 
Distance reading in mm : xxxx  
New line character : \n (10 decimal / 0x0A hex) 
 

 
Figure 11 - Message frame in text mode for 1px mode measurements 

 

 
Please refer to Section 5.5 for more details about error cases that lead to non                             
numerical output. 

 

 
Please note that there is no zero-padding for leading zeros. 

 
When using 2px mode or 4px mode the measured distances are displayed in millimeters,                           
separated from each other by a “,”‘ symbol. A new line character is only sent at the end of                                     
the measurements. For instance the 4px mode leads to a message of 9 to 17 bytes: xxxx,                                 
xxxx, xxxx, xxxx\n (the number of bytes depends on the number of digits in the distance                               
reading) 
 

 
Figure 12 - Message frame in text mode for 4px mode measurements 

 

 

The message frame for the 2px mode has the same structure as the 4px mode,                             
except that it contains only 2 distance readings, thus resulting in a 5 to 9 bytes                               
message. 
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5.2.2 BINARY mode (default) 

This mode providers users with measured distances displayed in the form of binary                         
messages using 4 bytes: TXXCRC8. Binary mode is the default printout mode of the sensor. 
 
In 1px mode, the checksum byte is calculated out of the first 3 bytes of the message                                 
(header byte and distance reading bytes) 
 
Header (1 byte)        : T (84 decimal / 0x54 hex) 
Distance reading in mm (2 bytes)       : XX  
Checksum (1 byte)        : CRC8 
 

 
Figure 13 - Message frame in Binary mode for 1px mode measurements 

 

 

The TeraRanger Evo Mini will output T01CRC (first distance byte set to zero and the                             
second to one) as an error message if the sensor is unable to measure a distance.                               
Please refer to Section 5.5 for more details about error cases. 

 
In 2px mode and 4px mode, the measured distances (2 bytes each) are displayed in                             
millimeters one after the other. The checksum is calculated at the end of the distance                             
measurements out of the first bytes of the message. For instance the 4px mode leads to a                                 
message of a 10 bytes: TXXXXXXXXCRC8 
 

 
Figure 14 - Message frame in Binary mode for 4px mode measurements 

 

 

The message frame for the 2px mode has the same structure as the 4px mode,                             
except that it contains only 2 distance readings; thus resulting in a 6 bytes                           
message. 
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5.3. Pixel modes: 1px, 2px and 4px 

5.3.1 1px mode 

In this pixel mode, the TeraRanger Evo Mini returns a single distance measurement in                           
millimeters, calculated on the entire 27° Field of View of the sensor. It is a default                               
parameter of all pixel modes.  

5.3.2. 2px mode 

When in 2px mode, the TeraRanger Evo Mini returns 2 distance measurements in                         
millimeters, with a 20° Field of View in the diagonal. Figure 15 shows the pixel layout and                                 
the order in which the measurements are streamed from the sensor. 

5.3.3. 4px mode 

When in 4px mode (2x2), the TeraRanger Evo Mini returns 4 distance measurements in                           
millimeters. Each measurement (pixel) has a 13.5° Field of View, which represents an area                           
of 24 cm x 24 cm at 1 m range. Figure 15 shows the pixel layout and the order in which the                                           
measurements are streamed from the sensor. 
 

 
Figure 15 - 1px mode (left), 2px mode (center), 4px mode (right) 

 

 

The pixel layout shown in Figure 15 both gives information regarding the position                         
of each pixel in space, and regarding the order in which the distances are                           
displayed (Pixel 1 = first distance output, Pixel 2 = second distance output,...)  
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5.4. Range modes: short-range and long-range 

5.4.1. Long range mode (default) 

When in long range mode, TeraRanger Evo Mini will allow for distance measurements                         
starting from 0.03m up to 3.3m range. This is the default range mode of the TeraRanger                               
Evo Mini. 

5.4.2. Short range mode 

When in short range mode, TeraRanger Evo Mini will sample data at a higher update rate                               
and return more accurate distance readings, at the expense of maximum range, which                         
corresponds to 1.35 m range. Please note that the short range mode does not support                             
applications that require measurements above 1.35 meters.  
 

 

When the TeraRanger Evo Mini is powered off, it automatically returns into its                         
default configuration modes: Binary print out mode, 1px mode, and long range                       
mode. 

 

5.5. Error cases 
Table 13 - TeraRanger Evo Mini data output for error cases 

Error cases output  BINARY  TEXT  

Detection below sensors minimum range  0X0000  -Inf\n 

Detection beyond sensors maximum range  0XFFFF  +Inf\n 

Invalid reading: 
- Ambient light too high 
- Target surface too reflective 

0x0001  -1\n 
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6. I2C normal operations 
 

 

Please note that streaming distance data via the I2C communication protocol                     
(using the I2C/UART interface backboard) is possible only using the 1px mode of                         
the sensors - in both: short-range and long-range modes.  

6.1. I2C Protocol information 
The I2C data protocol supports the following communication parameters: 

Frequency: 400kHz 
Primary Address Length: 7-bit 
Primary Slave Address: 0x31 
Built-in pull-up resistors: 10 kOhms on SDA and SCL (avoid additional pull-up 
resistors on the same bus to prevent transmission problems) 

 
The TeraRanger Evo Mini sensor is ‘free running’. This means that it will restart a new                               
measurement as soon as the last one is finished. The displayed data via I2C protocol is                               
always updated at the end of a measurement. Nevertheless, it can always be read at any                               
time. 
 
Reading the distance is done by first writing a Trigger Reading command to the sensor -                               
send 0x62 (this is a 7 bit address 0x31 followed by the Write bit ‘0’) and then reading from                                     
the sensor by sending 0x63 (the base address with the Read bit ‘1’) followed by three byte                                 
read operations. The first two bytes you receive are a 16 bit word containing the latest                               
measurement in mm, the third byte is the CRC8 checksum. 
For more details regarding the error messages regarding the I2C communication, refer to                         
Section 6.2. 

6.1.1. Write protocol 

To write commands to the TeraRanger Evo Mini, please follow the protocol described in                           
table 14. 
 

Table 14 - Write protocol in I2C 

Step  Action  Description 

1  Send address  Send the address byte consisting of a 7 bit base address                     
and the last bit indicating write (‘0’)  
 
e.g: 0x62 for base address 0x31 
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2  Send 
command 

Send the desired command listed in the table below (see                   
table below in the next paragraph) 

3  Read answer  In case the command creates an answer, read it back                   
immediately 

 
Three commands are available to the user to perform some basic actions with the sensors.                             
All four commands, that are exclusively “Write” operations, are listed in table 15. To get an                               
answer from the “write” operation, the user needs to perform a “Read” operation. For more                             
details about reading protocol, please refer to the next sub-section. 
 

Table 15 - List of I2C commands for the TeraRanger Evo Mini 

Command 
(HEX) 

Command name   Command description 

0x00  TRIGGER READING   Write this command to the TeraRanger Evo Mini and 
after 0.5 milliseconds, read three bytes from the 
sensor. 
 
The first two bytes received are a 16 bit message 
containing the latest measurement in mm, the third 
byte is the CRC8 checksum. 

0x01  WHO_AM_I Write this command to the TeraRanger Evo Mini via 
I2C and the Device responds with 0xa1.  
 
This functions to uniquely identify a TeraRanger Evo 
Mini on the I2C bus. 

0x02  0x0W  CHANGE_MODE Write this command to the TeraRanger Evo Mini to 
switch between the range modes : 
 
The value of W depends on the Mode : 
 
W= 1 : SHORT DISTANCE MODE 
W= 3 : LONG DISTANCE MODE  

0xA2 CHANGE_BASE_AD
DR 

Write this command followed by the new base 
address that needs to be set to the TeraRanger Evo 
Mini.  
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6.1.2. Read protocol 

To read commands from the TeraRanger Evo Mini, please follow the protocol described in table               
16. 
 

Table 16 - Reading protocol in I2C 

Step  Action  Description 

1  Send address  Send the address byte consisting of 7 bit base address and           
the last bit indicating read (‘1’)  
 
e.g: 0x63 for base address 0x31 

2  Read  Read back the number of bytes imposed by the command 
 
e.g: three bytes for a distance reading in 1px mode 

 

6.2. Error cases 
 

Table 17 - I2C error cases 

Error cases output  BINARY  TEXT  

Detection below sensors minimum range  0X0000  -Inf\n 

Detection beyond sensors maximum range  0XFFFF  +Inf\n 

Invalid reading: 
- Ambient light too high 
- Target surface too reflective 

0x0001  -1\n 
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7. Build multi-sensor applications 
TeraRanger Evo Mini is compatible with the TeraRanger Evo Hub accessory board for                         
multi-sensor applications. Available in kits with 4 or 8 Evo Mini sensor modules, benefit                           
from a plug and play approach to building custom sensor arrays addressing specific                         
sensing needs! The kit includes a central Hub that features built-in crosstalk avoidance                         
system for efficient multi-sensor use, and outputs all sensor data using a single UART or                             
USB interface.  
 
For more information regarding the Evo Mini Array Kits, please visit terabee website.  
 

 
Please note that TeraRanger Evo Mini only supports the 1px mode in long range                           
mode for compatibility with the TeraRanger Evo Hub accessory board.  

 

 
Figure 16 - Four TeraRanger Evo Mini sensors connected to Hub Evo  

 

   

 
Copyright © Terabee 2019 
Terabee, 90 Rue Henri Fabre 
01630, St Genis-Pouilly, France (next to CERN) 

 
28/29 



 
 

8. Optical characteristics  
 

8.1. Projected reception area  
 
TeraRanger Evo Mini is an optical distance measurement sensor, that uses infrared                       
Time-of-Flight principle. The sensor features a 27° degree Field of View, which corresponds                         
to a detection area of 48 cm x 48 cm (projected reception area) at 1 m range. Figure 17                                     
illustrates spotlight geometry of the sensor at different reference distances, when using                       
1px mode.  
 

 
Figure 17 - Projected reception area for 1px mode. 
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